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Software License Agreement
Carefully read the following terms and conditions sign and return as accepting
these terms and conditions.
This is a legal agreement between you, the end user (either an individual or an
entity), and Scanvec Amiable, Inc. If you do not agree with the following, you
should promptly return the package. Use of this program indicates your
acceptance of the terms and conditions stated below.
1. License.
The enclosed computer program "Software" is licensed, not sold, to you by
Scanvec Amiable, Inc., for use on a non-exclusive, non-transferable basis, only
under the following terms, and Scanvec Amiable, Inc., reserves any rights not
expressly granted to you. You may not disclose to any third party any
confidential information concerning the Software or Scanvec Amiable, Inc. or use
such confidential information to the detriment of Scanvec Amiable, Inc...
This software is protected by the United States Copyright Law and International
Treaty Provisions. Therefore, you must treat the Software just as you would any
other copyrighted material, such as a book. This license allows you to:
(a) Make one copy of the Software in machine readable form; provided
that such a copy of the original may be used solely for backup purposes.
As an express condition of this License, you must reproduce on each copy
of the Scanvec Amiable, Inc., copyright notice and any other proprietary
legends on the original copy supplied by Scanvec Amiable, Inc.
(b) Transfer the Software and all rights under this License to another party
together with a copy of this License and all written materials
accompanying the Software provided you give Scanvec Amiable, Inc.,
written notice of the transfer and the other party reads and agrees to
accept the terms and conditions of this License.
(c) Use this Software on a single computer only, but may transfer it to
another computer as long as it is used on only one computer at a time. “In
Use” constitutes being loaded onto either temporary (i.e., RAM) or
permanent memory (e.g., hard disk, CD-ROM or other storage device) of a
computer.
2. Restrictions.
You may NOT distribute copies of the Software to others or electronically transfer
the Software from one computer to another over a network. You may not decompile, reverse engineer, disassemble or otherwise reduce the Software to a
human perceivable form. You may not modify, adapt, transfer, rent, lease, loan,
resell for profit, distribute, network or create derivative works based upon the
software or any part thereof.
3. Termination.
This License is effective until terminated. This License will terminate immediately
if you fail to comply with any of its provisions. Upon termination, you must return
the Software, and all copies thereof, to Scanvec Amiable, Inc., and you may
terminate this License at any time by doing so.
4. Export Law Assurances.
You agree that neither the Software nor any direct product thereof will be
transferred or exported, directly or indirectly, into any country prohibited by the
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United States Export Administration Act or any international export laws and the
restrictions and regulations thereunder, nor will it be used for any purposes
prohibited by the Act or laws.
5. Warranty Disclaimer, Limitation of Remedies and Damages.
In no event will Scanvec Amiable, Inc., be liable for any damages, including
infringement, lost data, lost profits, cost of cover or other special, incidental,
consequential or indirect damages arising from the use of the program however
caused and on any theory of liability. This limitation will apply even if Scanvec
Amiable, Inc., or an authorized dealer or distributor has been advised of the
possibility of such damage.
SCANVEC AMIABLE, Inc. MAKES NO
WARRANTY, EXPRESS OR IMPLIED, WITH RESPECT TO THE SOFTWARE,
AND DISCLAIMS, WITHOUT LIMITATION, ANY IMPLIED WARRANTY OF
MERCHANTIBILITY OR FITNESS FOR A PARTICULAR PURPOSE. Scanvec
Amiable, Inc., does not warrant any drivers for plotting, scanning or either
devices. These drivers are provided for our customers as a service only, and
were developed using information provided to us at the time by the equipment
manufacturers.
Scanvec Amiable, Inc., is not responsible for any typographical errors in the
software or in the documentation.
6. General.
If you are a U.S. Government end-user, this License of the Software conveys
only "RESTRICTED RIGHTS," and its use, disclosure, and duplication are
subject to Federal Acquisition Regulations, 52.227-7013(c)(1)(ii). This License
will be construed under the laws of the State of Pennsylvania, except for that
body of law dealing with conflicts of law, if obtained in the U.S., or the laws of
jurisdiction where obtained, if obtained outside the U.S. If any provision of this
License is held by a court of competent jurisdiction to be contrary to law, that
provision of this License will remain in full force and effect.
© Copyright 2002 by Scanvec Amiable, Inc. All rights reserved. No part of this
publication may be reproduced, stored in a retrieval system or transmitted, in any
form or by any means, electronic, mechanical, photocopy, recording or
otherwise, without the prior written permission of the publisher. Printed in the
United States of America. The information in this manual is subject to change
without notice and does not represent a commitment on the part of Scanvec
Amiable, Inc.
Acrobat® Reader Copyright© 1987-2002 Adobe Systems Incorporated. All rights
reserved. Adobe and Acrobat are trademarks of Adobe Systems Incorporated
which may be registered in certain jurisdictions. PostScript®
software
Copyright© 1984-1998 Adobe Systems Incorporated. All rights reserved.
Flexi, FlexiFAMILY, FlexiSIGN-Pro, FlexiSIGN Plus, FlexiEXPERT, FlexiSIGN,
FlexiLETTER, FlexiDESIGNER, FlexiCUT, FlexiENGRAVE, PhotoPRINT Server,
PhotoPRINT, PhotoPRINT SE, EnRoute-Pro, EnRoute Plus, EnRoute, EnRouteMachine Shop, and/or other Scanvec Amiable products referenced herein are
either trademarks or registered trademarks of Scanvec Amiable, Inc. Illustrator is
a registered trademark of Adobe Systems Incorporated. FreeHand is a registered
trademark of Macromedia Corporation. CorelDRAW! is a trademark of Corel
Systems Corporation. AppleTalk, ImageWriter, LaserWriter, and Macintosh are
registered trademarks of Apple Computer, Inc. Windows is a registered
trademark of Microsoft Corporation. The names of actual companies and
products mentioned herein may be the trademarks and/or registered trademarks
of their respective owners. Adobe® is a trademark of Adobe Systems
Software License Agreement
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Incorporated or its subsidiaries and may be registered in certain jurisdictions.
PostScript® is a trademark of Adobe Systems Incorporated or its subsidiaries
and may be registered in certain jurisdictions.
Scanvec Amiable, Inc.
International Plaza Two, Suite 625
Philadelphia, PA 19113-1518
License Agreement for Users of Adobe® Configurable PostScript® Interpreter
and Coded Font Programs
1. Licensor grants to Licensee a nonexclusive sublicense, subject to Paragraph 7
below and the other provisions hereof (a) to use the CPSI Application Object
("Software") solely for Licensee's own internal business purposes in a single
central processing unit ("CPU"), optional associated display with a resolution of
less than one hundred fifty dots per inch, and, optionally, connected to a single or
multiple output device (the "Computer System"); (b) to use the digitally-encoded
machine-readable outline programs ("Font Programs") provided by Licensor in a
special encrypted format ("Coded Font Programs") and identified herewith to
reproduce and display designs, styles, weights, and versions of letters, numerals,
characters and symbols ("Typefaces") solely for Licensee's own customary
business or personal purposes on the Computer System; and (c) to use the
trademarks used by Licensor to identify the Coded Font Programs and
Typefaces reproduced therefrom ("Trademarks"). Licensee may assign its rights
under this Agreement to a licensee of all of Licensee's right, title and interest to
such Software and Coded Font Programs provided the licensee agrees to be
bound by all of the terms and conditions of this Agreement.
2. Licensee acknowledges that the Software, Coded Font Programs, Typefaces
and Trademarks are proprietary to Licensor and its suppliers. Licensee agrees to
hold the Software and Coded Font Programs in confidence, disclosing the
Software and Coded Font Programs only to authorized employees having a need
to use the Software and Coded Font Programs as permitted by this Agreement
and to take all reasonable precautions to prevent disclosure to other parties.
3. Licensee will not make or have made, or permit to be made, any copies of the
Software or Coded Font Programs or portions thereof, except as necessary for
its use with a single Computer System hereunder. Licensee agrees that any such
copies shall contain the same proprietary notices which appear on or in the
Software or the Coded Font Programs.
4. Except as stated above, this Agreement does not grant Licensee any rights to
patents, copyrights, trade secrets, trade names, trademarks (whether registered
or unregistered), or any other rights, franchises, or licenses in respect of the
Software, Coded Font Programs, Typefaces, or Trademarks. Licensee will not
adapt or use any trademark or trade name which is likely to be similar to or
confusing with that of Licensor or any of its suppliers or take any other action
which impairs or reduces the trademark rights of Licensor or its suppliers. The
Trademarks can only be used to identify printed output produced by the Coded
Font Programs. At the reasonable request of Licensor, Licensee must supply
samples of any Typeface identified by a Trademark.
5. Licensee agrees that it will not attempt to alter, disassemble, decrypt or
reverse engineer the Software or Coded Font Programs.
6. Licensee acknowledges that the laws and regulations of the United States
restrict the export and re-export of commodities and technical data of United
States origin, including the Software or Coded Font Programs. Licensee agrees
that it will not export or re-export the Software or Coded Font Programs in any
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form without the appropriate United States and foreign government licenses.
Licensee agrees that its obligations pursuant to this section shall survive and
continue after any termination or expiration of rights under this Agreement.
7. The Software licensed hereunder may be used to generate screen displays on
a single Computer System having a screen resolution of less than 150 dots per
inch and to generate output on the associated output device. Licensee agrees
not to make use of the Software, directly or indirectly, (i) to generate bitmap
images on a screen display with a resolution of 150 dots per inch or greater, (ii)
to generate Typefaces for use other than with the Computer System, or (iii) to
generate printed output on other than an output device that Licensor has
designated to be approved for use with the Software on the Computer System.
Any failure of Licensee to comply with this provision is a material breach of this
End User Agreement.
8. NEITHER LICENSOR NOR ANY OF ITS REPRESENTATIVES MAKES OR
PASSES ON TO LICENSEE OR OTHER THIRD PARTY ANY WARRANTY OR
REPRESENTATION ON BEHALF OF LICENSOR'S THIRD PARTY
SUPPLIERS.
9. Licensee is hereby notified that Adobe Systems Incorporated, a California
corporation located at 345 Park Avenue, San Jose, CA 95110-2704 ("Adobe") is
a third-party beneficiary to this Agreement to the extent that this Agreement
contains provisions which relate to Licensee's use of the Software, the Coded
Font Programs, the Typefaces and the Trademarks licensed hereby. Such
provisions are made expressly for the benefit of Adobe and are enforceable by
Adobe in addition to Licensor.
10. The Adobe Postscript Interpreter includes an implementation of LZW licensed
under U.S. Patent 4,558,302. The Adobe® PostScript© Interpreter, also referred
to as CPSI, is provided on an as is basis. Scanvec Amiable, Inc. is not
responsible for any damages arising from the use of the program however
caused and on any theory of liability.
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1. Installing the Software
Before you begin installing the software, read the hardware
requirements below. For optimal performance we suggest that your
system meet the recommended requirements. As with all computer
software, systems with faster processors, more RAM, and greater
amounts of storage space allow you to work with larger files and keep
your processing time to a minimum.

Recommended System Requirements
Windows
Processor

Pentium II 350 MHz

RAM

256 MB

Install Space

200 MB

Working Disk Space

4 GB

Operating System

Windows 98/ME/NT4.0/2000/XP

Video

800x600 resolution monitor with 16 bit color

Other

CD-ROM drive or DVD drive
Free USB or LPT port for hardware key
Available port for output device

Windows NT 4.0 requires Internet Explorer 5.X or greater & Service Pack 4
or higher.

Installing a Hardware Key
The software will not run without a hardware protection key, also known
as a dongle. The hardware key protects the software from being
unlawfully copied and must be connected to your computer whenever
you use the software.
There are two types of hardware keys: Parallel and USB keys.

Parallel key

USB key

Only the server requires a hardware key; client workstations do not.

1.

Turn off your computer.

2.

Plug the hardware key into the port (USB, or parallel).

Installing the Software
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3.

Turn on your computer.
When using parallel port keys, we recommend that you plug your output
device and key into separate parallel ports.

Installing the Software
Follow these steps to install the software:
If you’re installing on a PC running Windows NT/2000/XP, you must have
Administrator privileges. See your Windows user guide for details.

1.

Insert the Installation CD.

2.

Select a language and then click OK.

3.

Enter your user number and password and then click Next. The
User number and password can be found on the product hardware
key.

4.

Select the product and language to be installed and then click Next.

5.

On the Welcome screen, click Next to continue.

6.

Read the Software License Agreement and click Yes to accept.

7.

Click Yes to view the Readme file.
The Readme file contains last-minute issues and information that are not
included in this documentation.

8.

You may change the default destination folder here. Click Next.

9.

Select the folder where the software will be included. If you accept
the default folder, a new folder will be created for the product. Click
Next.

10. Click Yes to clear the preferences.
11. Select the printers you want to install color profiles for then click
Next.
12. Select Yes and click OK to restart your computer.
By default, the installation program places a shortcut to the software in the
Windows Startup folder. Each time Windows starts up, the software will be
loaded and minimized, and its icon will appear in the System Tray area of
the Windows Taskbar. To prevent the software from being loaded
automatically, delete the shortcut in the Startup folder. To shut down the
software, right-click on the icon in the system tray and select Exit.
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Preparing the Server to Receive Jobs from
Remote Clients
Before configuring remote clients you must complete a few basic steps
to prepare your server. The exact steps will depend on which operating
system the server computer uses. Please refer to the appropriate
section for your configuration.
If you will be printing from Macintosh clients, you must configure your
server to recognize the AppleTalk network protocol.

File and Printer Sharing Setup
File and Printer Sharing may already be set up on your system. If not,
follow these steps to prepare your system for file and printer sharing.
File and Printing Sharing Setup for Windows 98 and Windows NT
4.0
1. Click on Start then select Settings then click on Control Panel.
2.

Double-click on the Network icon.

3.

Click on the File and Print Sharing button under the
Configuration tab.

4.

Place checkmarks in both option boxes in the File and Print
Sharing screen then click OK.

5.

You will now see File and Printer Sharing for Microsoft
Networks in the Network screen. Click OK.

6.

Reboot as directed.

File and Printing Sharing Setup for Windows 2000
1. Click on Start then select Settings then click on Network and
Dial-up Connections.
2.

Right-click on the Local Area Connection icon and then click on
Properties.

3.

Click on the Install button under the General tab.

4.

Select Service in the Select Network Component screen then click
on the Add button.

5.

Select File and Printer Sharing for Microsoft Networks in the
Select Network Service screen. Click OK.

6.

You will now see File and Printer Sharing for Microsoft
Networks in the Network screen. Click Close.

File and Printing Sharing Setup for Windows XP
1. Click on Start then click Control Panel.
2.

If the Windows XP Control Panel is set to Classic View, doubleclick Network Connections. Otherwise, click on the Network and
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Internet Connections icon in the Control Panel. Then click on the
Network Connections icon.
3.

Double-click on the Local Area Connection icon and then click on
Properties.

4.

Click on the Install button under the General tab.

5.

Select Service in the Select Network Component screen then click
on the Add button.

6.

Select File and Printer Sharing for Microsoft Networks in the
Select Network Service screen. Click OK.

7.

You will now see File and Printer Sharing for Microsoft
Networks in the Network screen. Click Close.

Installing the AppleTalk Protocol
The software can receive Macintosh jobs if the AppleTalk protocol is
enabled.
Windows 98 and Windows XP do not support the AppleTalk protocol, so
servers running those operating systems will not be able to receive jobs
from Macintosh clients. If you have Macintosh clients on your network,
you should install the software on Windows NT or Windows 2000
operating systems..
Installing the AppleTalk Protocol on Windows NT Workstation
1. From the Start menu select Settings, and Control Panels.
Double-click on the Network icon.
2.

Select the Protocol tab and click the Add button.

3.

Select AppleTalk Protocol from the list.

4.

Follow the on screen instructions to install the AppleTalk protocol.
You will be asked to insert your Windows NT CD.

5.

Restart your computer.

Installing Services for Macintosh for Windows NT Server
1. From the Start menu select Settings, and go to Control Panels.
Double-click on the Network icon.
2.

Click on the Services tab.

3.

Click the Add button and select Services for Macintosh from the
list.

4.

Follow the on-screen instructions to enable Services for Macintosh.
You will be asked to insert your Windows NT CD.

5.

Restart your computer.
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Installing the AppleTalk Protocol on Windows 2000
1. From the Start menu select Settings, and Control Panels.
Double-click on the Network and Dial-Up Connections icon.
2.

Right-click on the Local Area Connection icon and select
Properties.

3.

Click the Install button.

4.

Select Protocol and click on the Add button.

5.

Select the AppleTalk protocol and click on the OK button.

6.

Click on the Close button.

7.

Restart your computer.

Creating Shared Macintosh Volumes (Windows NT Server,
Windows 2000 Server, and Windows XP Server only)
If you are planning to drag jobs from Macintosh clients into hot folders,
then you will need to create Macintosh shared volumes on the server.
1.

Open File Manager and select the hot folder.

2.

From the Macintosh File menu, select Create Volume.

3.

Enter a volume name and share it.

Installing the Software
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2. Configuring the Software
The illustration below shows some of the basic elements in your
software:

Toolbar
Setup
Pane
Print
Queue
RIP
Queue

Job
Preview
Pane

Hold
Queue

Basic Elements of Your Software
Queues
Files progress through three queues during the course of processing.
Hold Queue

This queue lists all jobs that have been sent to the
server but have not yet been moved to other queues. It
is a holding place for jobs before they are processed.

RIP Queue

This queue lists the jobs that are being RIPed, or have
finished RIPing.

Print Queue

This topmost queue holds jobs that are in the process of
being printed. Printed jobs are automatically deleted
from the queue.

Queue Column Headings
Note the column headings at the top of each queue:
Setup

The name of the device to which the file will be output.

Job Name

The name of the file, followed by its internal PostScript
name in parentheses.

Status

The current status of the job.

Sender

The name of the computer that sent the job.

Configuring the Software
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Dimensions

The physical dimensions of the job.

Copies

The number of copies to be printed.

File type

The format of the file.

Size

The size of the file.

Media

The type of media specified.

Color

The color mode of the job.

After Output

The instruction for what to do with the job after output.

Type

The type of job, print or contour.

Date

The date and time the job was added.

# of pages

The number of pages in the job.

Setup Pane
Each output device is represented by an icon in the Setup Pane.

Job Preview Pane
Double-clicking the job preview pane generates a preview of the
selected job.

Toolbar
A toolbar is located at the top of the main window. It contains tools for
the most commonly used functions.
To show or hide a toolbar, select Toolbar from the View menu.
The toolbar functions are:
Add Job

Adds a job to the selected output device.

Save As

Saves the selected job to a file.

RIP Job

RIPs the selected job, and leaves it in the RIP queue.

Print Job

Prints the selected job to the specified output device,
RIPing it if necessary.

Nest

Nests the selected print jobs together so as to use
the minimum amount of the output media.

Unnest

Unnests the selected set of nested jobs.

Abort

Stops selected file from RIPing or printing.

Delete

Deletes the selected job or jobs.
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Setting Up Output Devices
When you first open the software you are prompted to add a setup for
an output device. To add setups for any additional output devices, go to
the Setup menu and select Add Setup.
For details on how all the settings in the software interact, see “How
Application Preferences, Output Device Setups and Job Properties
Interact” on page 26.

Adding New Setups
To add new setups:
1.

From the Setup menu, select Add Setup.

2.

Select either Color Printers or Hybrid Devices.

3.

Select the manufacturer of the output device from the
Manufacturer list.

4.

Select the model of the output device from the Model name list.

5.

Click on the Next button to continue.

6.

Select the Port the output device uses for communication.

7.

Click the Finish button to finish adding the setup.

8.

You will be prompted to install a PostScript printer driver. This
driver forms an integral part of the output device setup. Click OK to
install the driver.
On Windows XP/2000, your system will automatically be configured with a
PostScript printer. On Windows 98/NT, follow the on-screen installation
instructions in the printer driver installer:

a.

In the Welcome screen, click Next.

b.

Click ACCEPT to accept the end user license agreement.

c.

Select Install a new PostScript printer and click Next.

d.

Under Printer Connection Type, select It is directly
connected to your computer (Local Printer) and click Next.

e.

Under Local Port Selection, click Next to accept the default
printer port.

f.

Under Select Printer Model, click Browse and select the
C:\Program Files\[Software]\PPD folder. Select the printer
model and click OK. Click Next to continue.

g.

If you want to be able to print to the setup from clients, carry
out the following steps (if you do not want to be able to print
from clients, select Not Shared and click Next to continue).
i.

Select Shared.

Configuring the Software
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ii.

Enter a Share name.

iii.

Select your computer’s OS in the list below.

iv. Click Next to continue.
h.

Click Next to accept the default name and settings.

i.

Click Install to install the generic PostScript printer driver.

j.

Select No to avoid further configuration and click Next.

k.

Clear the Yes, I want to read the ReadMe file box and click
Finish to finish the generic PostScript driver installation.

l.

Click Yes to reboot your computer.

Setting Up Desktop Printers as Output Devices
To set up a conventional printer as an output device:
1.

Add the printer to the computer as a standard Windows printer.

2.

When creating the setup in the software, select Desktop Printer
under Manufacturer, then select the print queue for the desktop
printer under Model name and click Next.
If the output device is a desktop printer, the Port list will be disabled.

3.

Click Finish to complete the setup. You will be prompted to install a
PostScript driver. Click OK to install the driver.
The steps for installing the PostScript printer are identical to those on page
9.

Selecting a Setup
To select a setup, highlight its icon in the Setup Pane. Only one device
can be selected at any time.

Setting Active Setups
To make a setup active, do one of the following:
•

Check the box next to its icon in the Setup Pane.

•

Select the setup icon, then from the Setup menu, select the Make
Active.

•

Right-click on the setup icon and select Make Active from the
context menu.

Deleting Setups
To delete a setup, do one of the following:
•

Select the setup icon in the Setup Pane and click on the Delete
button in the toolbar.

•

Select the setup icon in the Setup Pane, then from the Edit menu ,
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select Delete.
•

Select the setup icon in the Setup Pane and press the Delete key
on your keyboard.

•

Right-click on the setup icon in the Setup Pane and select Delete
from the context menu.

Editing Setup Properties
To edit the setup properties associated with a particular output device,
do one of the following:
•

Right-click the setup icon in the Setup Pane and select Properties.

•

Select the setup icon in the Setup Pane, then from the Setup
menu, select Setup Properties.

•

Double-click the setup icon in the Setup Pane.

Setup Properties - General Tab
The General tab displays information about the output device, media
size and port.
Manufacturer

Manufacturer of the output device.

Model

Model of the output device.

Setup name

Name of the setup.

Hot folder

The folder that the software will use to store job files
for this output device.

Port

Select the port to which the output device is
connected:
COM

Serial communication port. This port
is only supported by cutters.

FILE

File port allows you to save the
output data as a file.

FTP

Output devices that supports network
connection may support FTP
protocol. You are required to enter
the IP address assigned to the output
device.

LPR

Some network devices do not work
with TCP/IP and only with LPR
protocol. You are required to enter
the IP address assigned to the output
device.

LPT

Parallel port is the most common
method to connect printers to the
computer.

Configuring the Software
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SCSI

Use this port if your output device
supports SCSI connection.

TCP/IP

Use this port if your output device
supports network connection. You
are required to enter the IP address
assigned to your output device.

USB/FireWire

USB/FireWire drivers are provided
with output devices that support
them. Please make sure the proper
drivers are installed when using
these ports.

Browse

Allows you to locate the printer shared on the network
and select it as an output port.

Media

Select a media size that is currently loaded in your
output device. You can specify custom media sizes by
selecting Custom size from the list and then entering
the Width and the Height values. Width and Height
display the size of the media being used and not the
actual output area.

Margin

Displays the margin settings for the selected media
size. Changing the margin value will not affect the
position where the output will be done. Margin values
are only used to calculate the output area.

Job priority

The priority assigned to new jobs by default. Priority is
used to determine which jobs in a given queue will be
processed first.
High

All jobs with High priority will process
before any other jobs in the queue
are processed.

Medium

All jobs in the queue with Medium
priority will process before any jobs
with Low priority are processed.

Low

Jobs with Low priority are processed
after all High and Medium priority
jobs in the queue are processed.

A High priority job might not always print first. This is because the software
can RIP a number of jobs simultaneously. If a smaller job finishes RIPing
first, it will move to the Print queue first, and immediately start printing.

Setup Properties - Print Tab
The Print tab displays the settings related to the printing. The layout of
this tab may differ depending on the output device. On some output
devices, the settings will adjust automatically to its best settings as you
change some settings. Some settings may require manual adjustment.
Page 12
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Media

Select the media type the output will be printed on.

Print mode

Select the print quality for the output.

Resolution

Select the output resolution.

Driver
Options

Clicking this button displays the Driver Options dialog.
The Driver Options dialog contains settings specific to
the output device. Most of settings in the driver options
can also be set through the output device’s panel. See
your output device manual for more details.

Dither type

Select the dithering for the output.
Dither Type is the pattern in which the individual dots
that make an image are applied to the media. Each
dither type has advantages in terms of quality and RIP
speed. The default dither type is usually the best setting
for your machine.
The software offers several dithering options to optimize
your output. Usually, quality and speed are in tradeoff,
with KF Diffusion offering the highest quality and the LX
Diffusion or FMXPress offering the fastest processing
times.
The list of available patterns is in descending order of
quality and ascending order of speed.
KF
Diffusion

This is an enhanced version of the error
diffusion method. While it takes longer to
RIP (5-6 times more than FMXPress), it
provides the highest detail and contrast
for most inkjet printers.

Error
Diffusion

This method produces high-quality
images. The enhanced image quality
requires intensive processing (3-4 times
more than FMXPress), and the time it
takes to RIP a file using this method is
the second longest of the available
options.

Random
Diffusion

A balance between image quality and
RIP time. It takes 2-3 times longer than
FMXPress.

LX
Diffusion

A faster option as far as RIP times are
concerned. It’s a good choice for large
prints that will be viewed from a
considerable distance.

FMXPress

The default diffusion method. It’s the
fastest in terms of RIP time and is
suitable for most prints.

Configuring the Software
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Angled
Screen

Designed for use with thermal printers to
produce vibrant, saturated colors. This is
also used to produce screen print
positives. Click Screen to set advanced
options.

Density
adjustment

Select the density profile to be used by the output
device.

Perform
color
correction

Checking this option activates the color correction
settings. If this setting is not checked, incoming jobs are
assumed to have already color corrected in the design
application.

Use
embedded
ICC profile

Checking this option forces the RIP to use the ICC
profile information embedded in the job file.

ICC input
profile

Select the ICC input profile to use to convert the image
into a neutral color space. If you are not familiar with
color management theory, use the default values. To
add an ICC input profile from another source, click the
Add button. There are three types of ICC input profiles
that can be specified.
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CMYK

The CMYK input profile applies to all elements
of a job that are in CMYK color mode. If your
image is in CMYK color mode, then your file
was previously separated for output to a
specific output device. Whenever is possible,
use the profile used for separation in your
design application as the CMYK input profile.
Try using similar profiles for common ink sets
(such as CMYK SWOP or High End SWOP) if
you don’t have the matching profile.

RGB

The RGB ICC input profile applies to all
elements of a job that are in RGB color mode.
An RGB input profile can be for either a
monitor or a scanner. If you scanned your
image without color correcting it, it is
recommended to use the scanner profile as a
RGB input profile. If you have done any onscreen color correction, you should select
your monitor profile as a RGB input profile.

Gray

The Gray ICC input profile applies to all
elements of a job that are in grayscale color
mode. This may refer to either a grayscale
scanner or a grayscale monitor.

Configuring the Software

ICC output
profile

Once the image is in a neutral color space, the output
profile is used to convert the image into the color space
of the output device.
Select the ICC profile that matches the combination of
ink, media, resolution, and dither type of your output
device.
To add an ICC output profile from another source, click
the Add button.

Bitmap and
Vector
rendering
intent

Rendering intent specifies how a color space from the
input file gets mapped to the color space of the output
device. The rendering intent selected in the Bitmap
rendering field will be applied to bitmap images (raster
images) in your job file. The rendering intent selected in
the Vector rendering intent field will be applied to vector
objects (shapes, text, etc). Choose from one of the
following rendering intents:
Perceptual

This intent is best for photographic
images. Colors outside of the output
device’s gamut are either clipped or
compressed to fit the output device’s
color space.

Saturation

This intent is best for graphic images,
such as vector art, where vivid colors
are more important than true color
matching. Colors outside of the output
device’s gamut are mapped to colors at
the extent of the gamut’s saturation.
Colors that fall within the gamut of the
output device are shifted closer to the
gamut’s saturation extent. This
rendering intent may also be used to
boost colors within a photographic
image.

Relative
Colorimetric

This intent is best for images, such as
logos, where the output needs to match
the original image. Colors that fall
outside of the output device’s gamut are
clipped. This method may reduce the
total number of colors available. The
white point of Relative Colorimetric is
always zero

Configuring the Software
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Absolute
Colorimetric

This intent is similar to Relative
Colorimetric, but has a different white
point value. Absolute Colorimetric
represents colors relative to a fixed
white point value of D50. For example,
the white of paper A will be simulated
when printing on paper B. This intent is
best for color proofing.

Spot Color

This intent was created to supplement
the Saturation intent. Spot Color maps
colors similarly to the Saturation
rendering intent, but Spot Color
rendering intent produces the greatest
saturation possible, and should not be
used with photographic images.

Info

Clicking this button displays the Profile Properties
dialog. This dialog displays detailed information of the
selected output profile. Use this to check whether the
selected profile matches your media.

Color Mode

Select the color mode that matches the inks set in the
printer.

Print
separations

Select this option to print each color plane separately.

Color Keys

Select this option to make each color separation print in
the appropriate color. If this option is not selected, all
color separations will print in black.

Use Spot
Color
Mapping

Select this option to print spot colors based on settings
in global and custom color mapping.

Setup Properties - Layout Tab
The Layout tab allows you to specify the output layout.
RIP and
print jobs
when
received

Check this option to start processing immediately any
file that is added using the Add Job command. The
settings from the Setup Properties will be used for
output.

Rotate
image to fit
into media

Check this option to allow the software to rotate the
output automatically when the image does not fit in the
media at its default output orientation.

Default job
size

Select one of the following options for the default job
size:
Scale
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Select this option to enter the
enlargement/reduction factor in percentage.
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Default job
position

Fit to
media

Select this option to enlarge or reduce the
incoming file to fit the media size.

Custom

Select this option to specify the exact Width
and Height that is required for your output.

Select one of the following options for the default
position of the job on the output medium:
Select this option to output the job at the device’s
origin on the edge of the media. You can specify
the offset from the edges of the media entering the
values in the Offset H and Offset V fields.
Select this option to output a job in the center of
the media.
Select this option to output the job in the center of
a sheet of media.

Setup Properties - Cut Tab
The Cut tab allows you to specify settings related to cutting. Some
settings specific to certain cutters are not described here. Please
consult your cutter manual for more details.
Resolution

Set the resolution of your cutting device. The default
value is already set for optimal results. You should not
change this value unless you are experiencing
problems with your output (output size not matching
the size it was designed).

Passes

Specify how many times the blade will move over each
line

Advance
after plot

Check this option to advance the media after output
and reset the origin.

Curve
quality

Select how smooth you want the curves to be. The
default is already set for optimal results.

Send arc
commands

Best

Produces the smoothest curves but process
will be slower.

Faster

Produces faster output with lower quality.

Draft

Produces the quickest output with lowest
quality.

User

Allows you to set your own accuracy of
paths.

Activates the device’s internal curve handling.

Configuring the Software
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Knife offset

Allows you to enter custom values for knife offset.
Usually knife offset should not be changed from the
software. You should use the offset settings in the
cutter.

Send
packets

Specify the packet size sent to the device. This setting
only applies to a limited number of cutters and you
should not change unless your cutter requires it.

Reset

Restores the default settings.

Cutter Driver
Options

Displays the Cutter Driver Options dialog.

Setup Properties - Communication Tab
The contents of this tab vary according to the port used to connect to
the output device.
COM

Allows you to set the communication parameters (speed, data
format) for serial communication. The default settings should
already be properly set to work with your output device.

FTP

Allows you to set the IP address assigned to your output
device and the Printer/Queue name

TCP/IP

Allows you to set the IP address and Port number assigned to
your output device.

FTP or
LPR

Allows you to set the IP address and Queue name assigned
to your output device.

LPT

Allows you to set the timeout settings for the parallel port.

SCSI

Allows you to set SCSI IDs for your output device.
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Setup Properties Color Tab
The Color tab provides some basic tools to manually adjust the output
color. Move the slider to the left or right to decrease or increase
respectively the amount of that color in the output.
All

Allows you to quickly adjust all color channels as a group.

Contrast

Adjusts the contrast of the image.

Reset

The reset button will restore the values and settings to their
original state.

Setup Properties - Nesting Tab
Automatic
job
nesting

Select this option to allow the software to automatically
nest jobs using one or more of the criteria specified
below. This allows users to work more efficiently by
grouping their jobs for output. Users can add several jobs
into the queue and nest them into one job.
Number
of jobs
received

Select this option to automatically nest jobs
once the specified number of jobs has
accumulated in the queue.

Number
of
minutes

Select this option to automatically nest jobs
once the specified number of minutes has
passed.

Percent
coverage

Select this option to automatically nest jobs
once the specified percentage of the media
has been covered.

Print
daily at

Select this option to automatically nest jobs
once a day at the specified time.

Set Number of jobs received to 1 to automatically nest the pages of multipage jobs.

Setup Properties - Label Tab
You may choose to print crop marks and information about the job along
with any notes that you enter.
Color

Allows user to print labels with only black ink or all channels.

Width

Sets the width of the labels.

Print
Label

This option must be checked to have access to label
printing options.
Position

Position accesses a menu that allows you
to choose where to print labels relative to
the job

Font and Size

Allows user to select a font and font size.

Configuring the Software
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Printer Name

Prints your printer name on printout.

Resolution

Prints the resolutions settings on printout.

ICC output
Profile

Prints the ICC output profile used on the
printout.

Tile Number

Prints the tile row and column number.

Overlap

Prints the overlap distance between tiles.
Enter a negative number to create an
offset between tiles.

Job name,
size and type

Prints the job name size and type on the
printout.

Dither type

Print the selected dither type on the
printout.

Starting time
of RIP

Prints the time that the RIP process
started on printout.

Page number

Prints the page number for a multiple
page file.

Number of
Copies

Prints the number of copies made on
printout.

Note

Allows user to print a text note on printout.

Use
printer’s
marks

Allows user to select type of crop marks to be used on
printout.

Print
color
bands

Print color bands at the position selected.
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Setting Application Preferences
The Preferences dialog box lists global settings for the application.
For details on how all the settings in the software interact, see “How
Application Preferences, Output Device Setups and Job Properties
Interact” on page 26.
To display application preferences, from the Edit menu select
Preferences.

Application Preferences General Tab
The General tab contains preferences for the software.
After Output

Sets what to do with the job after output:
Delete

Removes jobs from the queue after output.

Hold

Places jobs in the Hold Queue after output.

Archive Saves the job after output.
Archive Path

Where archived jobs are saved.

Units

You can specify what units of measurement will display
by selecting the desired units from the list.

Archive
Format

The format archived jobs will be stored in.
Original
job

Archives the image in its original file format.
When you add the archived file back into the
software, it will need to be RIPed again
before printing.

Native
job

Archives the print data in the output device's
native language. No preview information will
be available. When you add the archived file
back into the software, it will not need to be
RIPed again before printing.

Job folder

Sets the default folder for the jobs.

Temporary
folder

Sets the folder for temporary files that are created
during the processing of jobs.
RIPing files requires a significant amount of storage
space. If the drive on which the temp directory has only a
small amount of storage space, you may want to consider
relocating the temp directory to a drive with more
available storage space.

RIP Band
Height

Sets the band size that is processed during RIPing.
Smaller values allow large files to RIP but will take
longer to process.
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Priority

Priority you want to assign to RIPing vs. output.
RIP

RIPing is faster, but output may be slower.

Normal

Both RIPing and output have equal priority.

Output

Output is faster, but RIPing may be slower.

Maximum
Sets the number of jobs that can be RIPed at one time.
number of RIP One RIP thread is required for each file being RIPed,
threads
and one RIP thread is required to generate a preview
for each file.
Allow remote
Send Now/
Interactive

If this option is selected, the software will allow Send
Now and Interactive operation from a remote design
station.

Auto load
preview on
adding job

If this option is selected, a preview will automatically be
generated for each job as it is added.
Note: Activating this setting may slow the speed of
loading jobs in the Hold Queue.

Enable
simultaneous
RIP and Print

If this option is selected, the software will RIP and print
the job simultaneously. RIPing and printing
simultaneously may affect overall performance.

Application Preferences Color Tab
The color tab lets you change the background color for the setup area,
print queue, RIP queue, and Hold queue.
To select a color, double click on the field to the right of the text. A color
selection dialog will appear. Choose a new color, click ok, and new color
will appear in the field.
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3. Configuring Clients
There are two types of clients: Windows and Macintosh. Setting them
up to send jobs to the server consists of setting up AdobePS to transmit
the job to the shared print queues on the server.
AdobePS must be set up for each output device setup on the server.
For instructions on preparing the server to receive jobs from clients, see
“Preparing the Server to Receive Jobs from Clients” page 3.

Windows Client Setup
If your client machine is running Windows NT/2000/XP, make sure you have
administrative privileges before installing.

1.

Insert the installation CD.

2.

Browse the installation CD and open the AdobePS folder. Open
the AdobePS folder and double click winsteng.exe.

3.

Follow the on screen installation instructions to install the
PostScript printer driver:
a.

In the Welcome screen, click Next.

b.

Click ACCEPT to accept the end user license agreement.

c.

Select Install a new PostScript printer and click Next.

d.

Under Printer Connection Type, select It is connected to
your network (Network Printer) and click Next.

e.

Type the network path of the shared printer queue on the
server into the space provided, or click Browse to select the
queue by browsing the network. When finished, click Next to
continue.

f.

Under Do you want to use this printer as your default
printer? and Would you like to print the test page?, select
No. Click Next to continue.

g.

Clear the Yes, I want to read the ReadMe file box and click
Finish to finish the PostScript driver installation.

h.

After you have finished installing, select Yes, I want to restart
my computer now and click Finish to restart your computer.

Client applications on this computer will now be able to send jobs to the
server for processing and printing.

Macintosh Client Setup
Macintosh clients can only be installed if the AppleTalk protocol is installed
on the server. AppleTalk is only supported on Windows NT and Windows
Configuring Clients
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2000. See “Installing the AppleTalk Protocol” on page 4 for details.

Installing the PostScript driver on Macintosh
1.

Open the Installation CD.

2.

In the Adobe PS 8.7 folder, double-click the install icon.

3.

Follow the on-screen instructions.

Configuring Macintosh Clients:
1.

From the Apple Menu select Chooser.

2.

Set AppleTalk to Active.

3.

Select the AdobePS icon.

4.

Select the output device or hot folder broadcast on the network. In
some cases two broadcast devices may appear in the list. One
device may just appear with the output device name, the other
device will appear with the output device “name@computer”. You
should select the device with the @ symbol in the name.

5.

Click the Setup button.

6.

Click the Select PPD button and browse the Installation CD for the
correct PPD for your output device.

7.

Close the Chooser.

8.

From the Print dialog of the design application select the correct
output device.

9.

Choose Background Printing and set it to Foreground. The
software will not function properly if it is set to Background.
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4. Processing Print Jobs
Once the server receives a job, it can be RIPed and printed by moving it
through the three queues in the main program window.

Sending Jobs to the Software
Jobs can be sent to the software in a number of different ways.

Printing from a Client Computer
The job can be printed directly from a client computer that has been
configured to use the software as a network printer.
The software is set up by default to automatically RIP and print any job
that is sent to it by a client computer. Jobs are moved from the Hold
Queue to the RIP and Print Queues, and are deleted after printing.

Copying the File to the Hot Folder
Each output device that has a setup in the software has a hot folder.
The hot folder is used to store all the files that are queued up for that
output device. By default, hot folders are installed in the C:\Program
Files\[Software]\Jobs folder.
The software continuously monitors each hot folder. Whenever a job is
copied or moved into a hot folder, it will automatically be added to the
Hold Queue.
The file must be of a supported file type. See Appendix A for the list of
supported file types.

Adding the Job from Within the Software
A print job that has been output to a file can be added to the Hold
Queue manually from within the software:
1.

Output the print job to a file. See Appendix A for the list of
supported file types.

2.

From the File menu, select Add Job.

3.

Select the file to be added and click Open.

Dragging a File into the Software
Dragging a file into the software will automatically add it to the queue it
is dragged into. The print job will be assigned to the setup selected in
the Setup Pane.
To specify the setup to be used, drag the file onto the appropriate setup
icon in the Setup Pane. The job will appear in the Hold Queue, assigned
to that setup.
The file must be of a supported file type. See Appendix A for the list of
Processing Print Jobs
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supported file types.

Setting Job Properties
Understanding Job Properties
The software is designed to maximize production efficiency by providing
multiple layers of control over your print jobs.
The Four Stages at which Properties Can be Set
Properties for a print job can be set at four different stages:
•

In the client application where the print job is generated

•

In the setup properties for the output device on the server where
the job is sent for printing

•

In the printer properties set on the client’s computer

•

In the job properties for the job itself.

Table 1 on page 27 lists which properties can be set at each stage.
How Application Preferences, Output Device Setups and Job
Properties Interact
In the list above, each stage overrides the settings in the stages above
it. The client application is overridden by the server setup, which is in
turn overridden by the printer properties and finally the job properties.
This has two useful results:
•

The printer settings on the client override the setup for the output
device on the server. This allows users at the client level to specify
their job settings in their printer properties without needing to
access the server.

•

The settings for the job properties override the settings for the
setup properties. This allows you to set the defaults for your printed
output at the setup level, or in the printer properties on the client,
and override them for specific print jobs as needed.

How the Job is Processed
The print job is not processed at each step along the way. Instead, the
print properties are passed along at each stage, and are only processed
when the job is RIPed.
For instance, if the software is set to print color separations, and you
check the appropriate box at both the client application level and in the
job properties, you still only get one set of separations that are
generated when the job is RIPed. It would not generate color
separations in the application, and then separations of those
separations when the job was RIPed on the server.
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Table 1. Stages at Which Specific Job Properties can be Set
Server
Setup
Properties

Client
Printer
Properties

Server
Job
Properties

Ink/media

X

X

X

Dither type

X

X

X

Rendering intent

X

X

X

What to do with file
after printing

X

X

X

X

X

X

X

X

X

Client
1
Application

Print as separations

X

Send instructions
(RIP and Print, RIP
then Print, RIP and
Hold)
Screening settings

X

X

Include labels with
printed jobs

X

X

X

Scale job

X

X

X

Fit job to media

X

X

X

X

Set Printing
resolution
Driver Options

X

X

X
X

X

Specify to use server
default settings
Cut media after
printing (If supported
by your device.)

X

X

X

X

X

1 The settings used in this table are typical for many software

applications; however the settings available from your desktop
application may vary. See your software’s user guide for more
information.
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Setting Job Properties Using the Job Properties Dialog
To access the Job Properties dialog, select the job and do one of the
following:
•

Double-click on the job.

•

From the File menu, select Job Properties.

•

Right-click on the job and select Job Properties from the context
menu.

Different tabs within the Job Properties dialog let you set general
properties for the job, layout options, Tiling/paneling options, color
calibration options, color adjustment options and labels. For certain
jobs, the contour cut options will also be available. Settings in Job
Properties only apply to the selected job.
Job Properties - General Tab
Setup

This is the name of the output device.

Media Size

The size of the material loaded in your output device.
Media Size displays the size of the media being used,
not the total printable area. The printable area on the
media will be slightly less than the actual area.

Width and
Height

Shows the current media's width and height.

After
Output

This determines what is done with the job after output.

Send

Delete

Removes the job.

Hold

Places the job back in the Hold Queue.

Archive

Stores the job in the archive folder set in
the Preferences dialog box.

If your job contains both printing and contour cut data,
this option allows you to choose what job information
will be sent to the output device. Choose from the
following options:
Print and
Contour

Sends both the printing and the contour
cut data to the output device.

Print only

Sends only the print data to the output
device.

Contour
only

Sends only the contour cut data to the
output device.

The Contour only option is only available for Print and
Cut devices. Use the Print only option if you need to
laminate the output before cutting.
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Print Pages
Only

If your job contains multiple pages, the print pages only
option will allow you to specify which pages you would
like to print.

Print after

If this option is selected, the software can be set to print
the job after a certain time of day.

Job priority

The priority you want to assign to your job. Priority is
used to determine which jobs in a given queue will be
processed first.
High

All jobs with High priority will process before
any other jobs in the queue are processed.

Medium

All jobs in the queue with Medium priority
will process before any jobs with Low priority
are processed.

Low

Jobs with Low priority are processed after all
High and Medium priority jobs in the queue
are processed.

A High priority job might not always print first. This is because the software
can RIP a number of jobs simultaneously. If a small low-priority job starts
RIPing after a high-priority job, but finishes RIPing first, it will move to the
Print queue first, and immediately start printing.

Job Properties - Layout Tab
Some of the buttons available in Job Properties include:
Size/
Mirror/
Rotate

Choosing one of these options allows you change the
output size and orientation of the page.
Width/ Height

Accepts direct entry of the job's width or
height. When one aspect is altered the
other is automatically updated to keep
the job proportionally correct.

Scale

Is used to increase or decrease the
job's size as a percentage of the
original. In most cases, a job's size
should be controlled from within the
application in which it was created to
prevent unexpected results.
Flips the selected image on the vertical
axis, so that your image will be
‘mirrored’ when printed.
Rotates image on the media in 90degree increments. Click the rotate
button until you achieve the desired
orientation.
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Position

Proportional

When this option is selected, the height
and width of the job are increased or
decreased together to keep the original
proportions intact.

Fit to Media

Increases or decreases the job
proportionally to fit maximum width of
the output device.

These settings change the position of the image on the
media.
Select this option to output the job at the
machine's origin on the edge of the media.
Select this option to output a job in the center of
the media.
Select this option to output the job in the center
of a sheet of media.

Copies

Offset V

Select this option to set a vertical offset distance
from the machine's origin.

Offset H

Select this option to set a horizontal offset
distance from the leading edge of the media.

Spacing

This is the amount of space given between
each tiles, copies and nested jobs.

Nesting

Select this option to automatically nest the
pages and/or tiles of a multi-page print job.
See “Nesting Jobs” on page 37 for details.

Sets the number of copies of the job to be printed.

Job Properties - Tile Tab
Tiling allows you to break up your job into specifically sized pieces. Most
often tiling is used to output a job that is larger than the media loaded in
the output device. To achieve the desired size, you can divide your
panel in any number of ways using the controls in the Tile tab, or
manually, by clicking and dragging to define new tile areas.
Media Size
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Shows the width and height entered for the media
size of the media loaded in your output device.
The sizes displayed here reflect the size of the
media entered in the General Tab.
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Page Size

Shows the width and height entered for the page
size of the job. The Page size is set from inside
the desktop application that created the job.
Page size is stored in PostScript files and
displayed here.

Selected Tile

Selects which tile’s width and height are
displayed in the fields below.

Width and Height

Shows the width and height of the selected tile.
To adjust, enter a number or use the arrows.

All Tiles

These settings apply to all tiles and help you
quickly set up automatic tiles, of equal size.
Even
Column

Selecting this option divides the
job vertically into the number of
columns specified. Each column
will be of equal width.

Even Row

Selecting this option divides the
job into the number of rows
specified. All rows will be of equal
height.

Lock Width
and Lock
Height

If you know that you want tiles of a
certain size, you may enter the
values here for the width and
height of the tiles. The sizes will
then be applied to all tiles.

Overlap

Sets the amount of overlap
between tiles. Enter a negative
number to create an offset
between tiles.

Send Tile Map to

Selects the output device setup the tile map will
be output to.

Reset

The reset button will restore the original values
and settings.

Send

Outputs the tile map to the selected setup.

Job Properties - Print Tab
Media

Select the type of media you are outputting onto.

Print Mode

Select the desired quality of your print. This setting will
vary for each type of printer.

Resolution

Choose an appropriate DPI (dots per inch) for your job.
A higher DPI value improves the resolution of the job,
but slows down the output. Higher DPI values may not
be necessary for all jobs.
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Driver
Options
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Clicking this button launches the Driver Options dialog.
The settings in Driver Options will vary depending on
your output device. Some common driver options
include.
Enable driver
options

Allows you to use the available
driver options for your output
device. When driver options are
enabled, you can set special
options from within the driver
options dialog. When driver options
are disabled, the default options
will be used.

Passes/
Enhanced mode/
Banding method

Sets the number of passes made
by the print heads on the printer.
This setting determines the number
of pixels that the printer advances
between passes. The higher the
setting the less the printer
advances between passes.

Print direction/
Print mode

Direction the print heads move
when printing. In Bi-directional
mode the print cartridges print from
left to right, then from right to left.
In unidirectional mode, the
cartridges print from right to left
only. Bi-directional mode prints
faster, but unidirectional mode
usually produces a better quality
print.

Dry time

This is the amount of time the
printer waits after it has completed
printing, allowing the ink to dry.

Firing rate/
Carriage speed

The speed at which the print heads
fire. The faster the print heads fire,
the faster the device prints, but a
faster firing rate may result in a
lower quality print.

Cut after print

Cuts the media after the print is
complete. If a drying time has been
set, the media will be cut after the
dry time is finished.

Microweave

A higher quality printing option,
which interlaces the passes while
printing.
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Enhanced
resolution

Allows the printer to simulate a
higher resolution.

Enable varware

A particular setting, which controls
print quality and speed. Available
only for a particular brand of
printer.

Pile up/
Overprint

Number of times you would like the
printer to print over the same area.
This setting increases the number
of ink layers placed on the media.

Dither Type

Sets the dither type to be used by the print job.
See “Dither Types” on page 13 for details.

Screen

This button is enabled when Angled Screen is selected
in the Dither type. It allows you to specify the screen
frequency, angle and shape for each color channel.

Density
Adjustment

Selecting a density file applies the densities created
though the Density Adjustment module. If you do not
wish to apply a density adjustment, set this field to
None.

Perform
Color
Correction

Checking this setting activates the color correction
settings. If this setting is not checked, incoming jobs are
assumed to already have color correction.

Use
embedded
ICC profile

Checking this option forces the RIP to use the ICC
profile information embedded in the job file.

ICC input
profile

Input profiles are used to convert the image into a
neutral color space.
See “ICC Input Profile” on page 14 for details.

ICC output
profile

Select the ICC profile that matches the combination of
ink, media, resolution, and dither type of your output
device.
See “ICC Output Profiles on page 15 for details.

Bitmap and
Vector
rendering
intent

Select the bitmap and vector rendering intents to be
used.
See “Bitmap and Vector rendering intent” on page 15 for
details.

Color Mode

If your output device supports multiple color modes, then
you can select one of the supported color modes here.

Print as
separations

When selected, this option prints each of the selected
colors (CMYK) in black ink as separate jobs. This option
is used for preparing jobs for separate color printing or
screening.
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Use spot
color
mapping

If this option is selected, the software will map spot
colors in the job to a specific output value. Mapped
colors will bypass color management and use the exact
value set in the Spot Color Mapping dialog (See “Using
Spot Color Mapping” page 40 for details).

Job Properties - Cut Tab
Use the Cut tab to display and edit information for contour cut jobs. This
tab will only be displayed when a contour job is selected. Cut properties
include all settings related to cutting and plotting.
See “Setup Properties – Cut Tab” on page 17 for details.
Job Properties - Color Tab
The Color tab provides you some basic tools to manually adjust the
output color.
See “Setup Properties – Color Tab” on page 19 for details.
Job Properties - Label Tab
You may choose to print crop marks, and information about the job
along with any notes that you enter.
Color

Allows user to print with only black ink or all channels.

Width

Sets the width of the labels.

Print
Label

This option must be checked to have access to label
printing options.
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Position

Select where to print labels relative to
the job.

Font and
Size

Allows user to select a font and font
size.

Printer
Name

Prints your printer name on printout.

Resolution

Prints the resolutions settings on
printout.

ICC output
Profile

Prints the ICC output profile used on
the printout.

Tile Number

Prints the tile row and column number.

Overlap

Prints the overlap distance between
tiles.

Job name,
size and
type

Prints the job name size and type on
the printout.
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Dither type

Print the selected dither type on the
printout.

Starting
time of RIP

Prints the time that the RIP process
started on printout.

Page
number

Prints the page number for a multiple
page file.

Number of
Copies

Prints the number of copies made on
printout.

Note

Allows user to print a text note on
printout.

Use
Printer’s
Marks

Allows user to select type of crop marks to be used on
printout.

Print color
bands

Print color bands at the position selected.

Job Properties - Job Preview Panel
In the job preview panel of Job Properties you may use the following
tools:
•

Select an object

•

Zoom tool

•

Zoom to page
Preview - Layout, Panel, Page
Page - If the job has multiple pages use this setting to see the
other pages.

Selecting Jobs in a Queue
Multiple jobs can be selected using the standard Windows CTRL and
SHIFT methods.
To select all the jobs in a queue, open the Edit menu and select Select
All.

Moving a Job to a Different Output Device
To move a job to a different output device setup:
•

Select the job and select Move from the File menu, then select the
new setup and click OK.

•

Click and drag the job onto the icon for the new output device’s
setup in the Setup Pane.
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RIPing Jobs
To move a job into the RIP Queue:
•

Select the job and from the File menu, select RIP.

•

Drag the job into the RIP Queue with the mouse.

•

Right-click the job and select RIP from the context menu.

Once a job is moved into the RIP Queue, it will automatically be RIPed if
it has not been RIPed previously.
Jobs in the RIP Queue will process in the order of the Job Priority
setting in their Job Properties. When multiple jobs with the same priority
are waiting in the queue, the job that was received first will process first,
even if a more recently received job has been sitting for a longer time in
another queue.

Printing Jobs
To move a job into the Print Queue:
•

Select the job and from the File menu, select Print.

•

Drag the job into the Print Queue with the mouse.

•

Right-click the job and select Print from the context menu.

Once a job is moved into the Print Queue it will be automatically be
RIPed if it has not been RIPed already. It will then automatically be
printed on the appropriate device.
Jobs in the Print Queue will process in the order of the Job Priority
setting in their Job Properties. When multiple jobs with the same priority
are waiting in the queue, the job that was received first will process first,
even if a more recently received job has been sitting for a longer time in
another queue.

Aborting the Processing of a Job
To abort the processing of a job while it is being RIPed or printed:
•

Select the job and from the File menu, select Abort.

•

Select the job, then click on the Abort button in the toolbar.

•

Right-click the job, then select Abort from the context menu.

•

Drag the job back into the Hold Queue with the mouse.

If a job is aborted while being RIPed, its status is set to Aborted. It will
need to be RIPed again before it can be printed.
If a job is aborted while being printed, its print status freezes at 0%.
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Deleting a Job
To delete a job:
•

Press the Delete key on your keyboard.

•

Select the job and from the Edit menu, select Delete.

•

Select the job, then click on the Delete button in the toolbar.

•

Right-click the job, then select Delete from the context menu.

Nesting Jobs
The software has the ability to nest jobs together in order to minimize
the amount of material needed to output the jobs. Jobs must be in the
same queue in order to be nested together, and must share the same
output device and resolution.
To nest jobs:
1.

Select the jobs.

2.

From the File menu, select Nest Jobs.

To separate a set of nested jobs into its component jobs:
1.

Select the set of nested jobs.

2.

From the File menu, select Unnest Jobs.

Automatic Nesting
The software can be set to automatically nest jobs as they are added to
the Hold Queue.
Automatic Nesting is set up in the Setup Properties for the output
device. See “Setup Properties – Nesting Tab” on page 19 for details.
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Tiling a Job
The tiling feature of the software allows you to split a print job up into a
number of smaller tiles that are then output separately. This can be
used to produce a larger job than a device is capable of outputting in
one piece.
All tiling is done from the Tile tab of the Job Properties dialog. To
access the tiling features:
1.

Select the job.

2.

Open the Job Properties dialog in one of the following ways:

3.

•

From the File menu, select Job Properties.

•

Double-click on the job in the queue.

•

Right-click on the job and select Job Properties.

Select the Tile tab.

Splitting a Job into Tiles
Editing Selected Tiles
The Selected Tiles section of the Tile tab allows you to edit the tiles in
your job one at a time.
To use this section of the tab, select the desired tile and adjust its
Height and Width.
Adding Tiles
To create a new tile, reduce the size of an existing tile. The software will
place a new tile over any uncovered area.
Tiling a Job Evenly
The All Tiles section of the Tile tab allows you to divide a job up into
uniform tiles.
To divide up a job into equally-sized columns and/or rows:
1.

Select the Even Column and/or Even Row options. Selecting both
options will split the job up into an even grid.

2.

In the field to the right of the option, select the number of rows
and/or columns you want to split the job into.

To divide a job into tiles of a uniform size:
1.

Select the Lock Width and/or Lock Height options.

2.

In the field to the right of the option, enter the desired height and/or
width of the tiles.
If the uniform tiles do not cover the job exactly, the remainder will be
covered by partial tiles.
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Editing Tiles In the Preview Pane
To resize tiles in the preview pane, drag the borders with the mouse.
To add columns or rows, drag one of the outside edges of the job into
the middle.
Specifying Overlap
To specify the amount of overlap between rows and columns, change
the value in the Overlap field. By overlapping, you can eliminate any
gaps between the tiles when assembling the final output. Overlap is
measured as the total amount two rows or columns overlap.

Preventing a Tile From Being Output
To specify a tile that will not be output:
•

Double click or right click the tile. The tile will be disabled.

Removing All Tiling
To remove all tiling and make the job one piece again, click on the
Reset button.

Printing a Tile Map
The software can print out a map showing how the job will be broken up
into tiles. Each tile has the tile number printed within its outline.
To print a tile map:
1.

Open the Job Properties for the job and select the Tile tab.

2.

Under Tile map printer setup, select the printer you want to use to
print the tile map.
If you would like to send the tile map to a desktop or network printer, first
create a setup for that printer, then select that setup here.

3.

Click the Print Tile Map button to print the tile map.

Using the Color Profiler
For instructions on using the Color Profiler module, consult the Color
Profiler PDF in the Readme folder on your Installation CD.

Using Density Adjustment
For instructions on using the Density Adjustment module, consult the
Color Profiler PDF in the Readme folder on your Installation CD.
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Using Custom Color Mapping
Custom Color Mapping allows you to map spot colors to exact output
values for your specific output device. Mapped colors will always print
out using the output values set in the Custom Color Mapping module,
overriding any other color management settings.
If you have mapped a custom color but don’t want to use that particular
color mapping for a particular job, you have two choices: turn off all custom
color mapping, or delete the color mapping for that particular color.

Each custom color mapping applies to a single color mode on a single
output device. If you want to map the same custom color to multiple
color modes, you must make multiple custom color mappings, one for
each color mode.
Custom color mapping is only applied to jobs in a vector format such as
EPS or PostScript. It does not affect bitmaps or JPEGs.
Custom color mapping only affects jobs that were added after the color
mapping was added. Jobs that were already queued are not affected.

To access the Custom Color Mapping module, open the Setup menu
and select Custom Color Mapping.

Adding a Custom Color Mapping
To map a custom color:
1.

Select the output device from the Printer Name list.

2.

Select the color mode you want to map the custom color to from the
Color Mode list.

3.

Click on the Add button in the Custom Color Mapping toolbar.
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4.

Type a name for the color in the Color field.

5.

Select the percentage values for each of the process colors in the
color mode selected.

6.

If desired, click on the Print Swatch button to print a set of
swatches for the color to help you fine-tune your choice (see below
for details).

7.

When finished, click on the OK button.

Printing Color Swatches
The Print swatch button prints out sets of color swatches, which allow
you to fine-tune your process color values. Enter the X and Y value from
the printout for the closest matching swatch. Update color will update
the process colors based on the swatch chosen.

Modifying a Custom Color Mapping
To modify a custom color mapping:
1.

Select the output device from the Printer Name list.

2.

Select the color mode associated with the color mapping from the
Color Mode list.

3.

Click on the Modify button in the Custom Color Mapping toolbar.

4.

Adjust the color mapping as desired.

5.

When finished, click on the OK button.

Importing the Custom Colors from a Print Job
The software can import all of the custom colors specified in a
PostScript or Encapsulated PostScript file.
To import the custom color definitions from a file:
1.

Click on the Import button in the Custom Mapping toolbar.
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2.

Select the file to import from and click on the OK button.

Printing Custom Colors
To print out a table of all the custom colors that have been specified for
the selected color mode, click on the Print Custom Colors button in the
Custom Mapping toolbar.

Deleting a Custom Color Mapping
To delete a custom color:
1.

Select the custom color from the list.

2.

Press the Delete key or click on the Delete button in the toolbar.
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Using Global Color Mapping
The Global Color Mapping module allows you to map the colors in your
job using LAB color space, a device-independent color space.
Global color mapping only affects jobs that were added after the color
mapping was added. Jobs that were already queued are not affected.

To access the Global Color Mapping module, open the Setup menu and
select Global Color Mapping.

Adding a Global Color Mapping
To add a global color mapping:
1.

Click on the Add button in the Global Color Mapping toolbar.

2.

Type a name for the color in the Color field.

3.

Enter the LAB values for the color selected.

4.

If desired, click on the Measure button to measure a sample of a
color with a colorimeter.

5.

When finished, click on the OK button.

Modifying a Global Color Mapping
To modify a global color mapping:
1.

Click on the Modify button in the Global Color Mapping toolbar.

2.

Adjust the color mapping as desired.

3.

When finished, click on the OK button.

Deleting a Global Color Mapping
To delete a global color mapping:
1.

Select the global color from the list.
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2.

Press the Delete key or click on the Delete button in the toolbar.

Using RIP Logs
Each time a job is RIPed, an entry for that job is added to the RIP Log
for that output device. The RIP Log entry lists the relevant details about
the job: where it came from, its basic characteristics, what job properties
were set, and the time at which it started and finished RIPing.

Viewing RIP Logs
To view the rip log for a given output device:
1.

Select the setup icon for the output device.

2.

From the View menu, select View RIP Log.

The RIP Log is formatted as an HTML file, and displays in the default
browser for the operating system.

Clearing RIP Logs
To clear out the rip log for a given output device:
1.

Select the setup icon for the output device.

2.

From the View menu, select Clear RIP Log.

Exiting the Software
Under normal operation, the software loads automatically each time the
OS is restarted (using a shortcut in the Startup folder) and runs
minimized, displaying an icon in the system tray area of the Windows
taskbar.
The software is designed to run all the time the computer is operating.
“Exiting” the software by clicking on the Close button in the title bar
merely cause the software to be minimized.
To actually exit the software, from the File menu select Exit, or rightclick on the software icon in the system tray and select Exit from the
context menu.
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5. Maintenance and Uninstalling
Clear Preferences
Clear Preferences is a utility that removes all output device setups and
returns the software to its default settings. It is particularly helpful when
troubleshooting any problems you may encounter with your software.
To clear the preferences stored in your system:
1.

Exit the software.

2.

Browse through the Windows Start menu to the folder for the
software and click on the Clear Preferences utility.

3.

Select Yes when you are asked if you would like to clear your
preferences.

Install Password
The Install Password utility helps you manage the different passwords
that come with the software. After you have installed the basic program
with your main password, you should then launch the Password Installer
to add any additional passwords you may have.
Application Password - This is your main application password for
software.
Option passwords- If you have purchased additional options, you may
enter the option passwords to this field to upgrade your software.
Make sure that the software is not running when you add a new password.

To add additional passwords:
1.

Browse through the Windows Start menu to the folder for the
software and click on the Install Password utility.

2.

Add your additional passwords to the optional password section by
clicking the Add button, and entering the password into the dialog.

3.

When you have finished, your password should appear in list in the
optional password field.
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Uninstalling the Software
1.

Exit your software by selecting Exit from File menu, then rightclicking on the software icon in the system tray and selecting Exit.

2.

In the Windows Control Panel, double-click the Add/Remove
Programs icon.

3.

Select your software from the list and click the Change/Remove
button.

4.

Click OK when finished.

5.

Delete the folder on your hard drive that the software was installed
into (C:\Program Files\[Software], for example), then empty the
Windows recycling bin.

Uninstalling Windows Clients
1.

Open the Windows Start menu and select Settings then Printers.

2.

Delete the printers which have been set up for the output devices
connected through the software.

Uninstalling Macintosh Clients
1.

Delete the PPD from the System-Extensions- Printer Descriptions
folder.

2.

Delete Adobe PostScript from in the extensions folder.

3.

Clear Adobe preferences found in the System folder, Preferences,
Printing Prefs. Delete Adobe PostScript prefs.
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Appendix A: Supported File Types
The software supports the following file formats:
File Format

Extension

Import

Export

Joint Photograph
Experts Group (JPEG)

jpg

*

N/A

Tag Image File Format
(TIFF)

tif

*

N/A

pdf

1.3

N/A

ps, EPS, 2ps, fjb, prn

3.0

N/A

bmp

*

N/A

prt, plt

*

*

Plot / Cut Job Files

job

*

*

Print Job Files

fjb

7.0

N/A

Kodak PhotoCD

pcd

*

N/A

Portable Document
Format (PDF)
PostScript
Windows bitmap
Native Files

* Version number does not exist or is not applicable.
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Index
aborting RIP or output
8, 38
active setup
10
angled screen dithering
14
AppleTalk protocol
4
application preferences
21
archiving printed jobs
21
automatic job nesting
19
automatic loading at startup 2
automatic nesting
39
background colors
22
banding method
34
bitmap rendering intents 15, 35
carriage speed
34
clients
installing Macintosh clients
25
installing Windows clients 23
Macintosh
AppleTalk protocol
needed on server
4
creating Macintosh shared
volumes
5
preparing server for clients 3
uninstalling Macintosh
clients
48
uninstalling Windows clients
48
color
adjusting
19, 36
correction
14, 35
modes
16, 35
separations
16
color bands
20, 37
Color Profiler
41
color separations
35
communication
18
contour cutting
17, 30, 36
crop marks
20, 37
cut after print
34
default job position
17
default job size
17
deleting jobs
8, 39
Density Adjustment 14, 35, 41
dithering
13, 35
dongle
See hardware keys
Index

dry time
34
enhanced mode
34
error diffusion
13
exiting the software
2
file and printer sharing
3
file types
49
firing rate
34
FMXPress diffusion
14
hardware keys
1
Hold queue
background color
22
holding printed jobs
21
hot folders
27
ICC input profiles
14, 35
ICC output profiles
15, 35
Install Password utility
47
installation
hardware keys
1
Macintosh Clients
25
system requirements
1
Installation
2
job preview pane
8
job properties
interaction with other
settings
28
jobs
aborting
38
adding
8, 27
archiving
30
changing output devices 37
contour cutting
30, 36
default position
17
default size
17
deleting
8, 39
dithering
35
fitting to media
32
labelling
19, 36
media type
33
nesting
8, 19, 39
outputting
8, 38
previewing
37
printing a tile map
33, 41
printing color separations 35
priority
12, 31
RIPing
8, 38
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rotating
17
saving to file
8
selecting
37
tiling
32, 40
unnesting
8
KF diffusion
13
labels
19, 36
license agreement
ii
License Agreement
2
LX diffusion
14
Macintosh clients
4
media type
33
microweave
34
nesting
8, 19, 39
automatic
39
network printers
10
number of copies
32
number of passes
34
options
application preferences 21
how options interact
28
job properties
28
setup properties
11
ports
11
PostScript drivers
installing on Macintosh
25
preferences
application
21
clearing
47
print direction
34
print mode
33, 34
Print queue
background color
22
printer's marks
20, 37
printing
38
printing color separations
16
queues
7
column headings
7
random diffusion
14
rendering intents
15, 35
resolution
13, 33
RIP band height
21
RIP queue
background color
22
RIPing
8, 38
number of threads
22
priority vs. output
22
RIP band height
21
RIPing and printing jobs on
receipt
17
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simultaneous RIP and print
22
rotating an image
17
saturation
15
screen
14, 35
server
setup
file and printer sharing 3
server preferences
interaction with other
settings
28
setup properties
interaction with other
settings
28
setups
9
adding
9
color
19
communication
18
cutting
17
default job position
17
default job size
17
deleting
11
desktop printers
10
editing
11
labels
19
nesting
19
selecting
10
sharing, file and printer
3
simultaneous RIP and print 22
spot color
rendering intent
16
spot color mapping
42
Startup folder
2
system requirements
1
system tray icon
2
temporary folder
21
tile map
33, 41
tiling jobs
32, 40
toolbars
8
uninstalling the software
48
units of measurement
21
USB
hardware keys
1
vector rendering intents 15, 35
Windows 2000
creating Macintosh Shared
Volumes
5
file and printer sharing
3
installing AppleTalk
5
Windows 98
Index

AppleTalk protocol not
supported
file and printer sharing
Windows NT
creating Macintosh Shared
Volumes
file and printer sharing
installing AppleTalk
installing Services for
Macintosh

Index

4
3
5
3
4

Windows NT/2000
administrator privileges
needed for installation
Windows XP
AppleTalk protocol not
supported
creating Macintosh Shared
Volumes
file and printer sharing

2
4
5
3

4
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